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Appropriate Use and Security of Confidential and Sensitive Information 

Due to the integrated nature of the various Human Resources, Finance and Student modules in 
Banner and the reporting information in the Enterprise Data Warehouse (EDW), you may have 
access to information beyond what you need to perform your assigned duties. Your access to 
Banner and the EDW has been granted based on business need, and it is your responsibility to 
ensure the information you access is used appropriately. 
 
Here are some reminders of good data stewardship to help you carry out your responsibility: 

• Do not share your passwords or store them in an unsecured manner. Do not leave 
your workstation unattended while logged on to administrative information systems. 
You are responsible for any activity that occurs using your logon id.  

• Do not share confidential and sensitive information with anyone, including colleagues, 
unless there is a business reason.  

• Retrieve printed reports quickly, and do not leave the reports lying around in plain 
view.   

• Secure reports containing confidential and sensitive information (e.g., FERPA, EEO or 
HIPAA protected data).  

• When disposing of reports containing confidential or sensitive information, shred the 
documents in a timely manner. 

 
Your responsibilities regarding the protection and security of administrative information are 
outlined in the University of Illinois Information Security Policy posted at 
https://www.obfs.uillinois.edu/bfpp/section-19-business-systems-access-security/section-19-5. 
Any violation could subject you to disciplinary action, which could include dismissal or, in those 
cases where laws have been broken, legal action. You should have signed a compliance form 
that indicates you have read, understand and agree to comply with the University's 
Information Security Policy for Administrative Information. If you have not already signed the 
compliance form, please see your Unit Security Contact, who is responsible for maintaining 
these forms. 
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About this Course 

Objective 

The objective of this course is to teach the basic functionality of the Web Intelligence editor for 
creating reports from the Enterprise Data Warehouse. 
 

Instructor Led Course 

This course is presented in a computer lab with an instructor. The instructor presents the 
information by completing the examples in each chapter on the screen. The students in the 
class follow by doing the same steps as the instructor. The students will then do exercises on 
their own. 
 

Training Data 

This course is designed to teach how to use the Web Intelligence editor to create reports, not 
the data. We will use the EDW – STU – Course Schedule universe for all the examples. This 
universe lists current and past course schedules for the three campuses.  
 

Training Accounts 

To access the training data, we will login using training accounts.  
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Chapter 1: Creating a Basic Report 

SAP Business Objects Products 
SAP Business Objects is a software suite of report creation, viewing, and distribution tools. 
Business Objects is composed of applications that are accessible through the web or on your 
desktop computer. The major components that you will interface with are: 
• BI Launchpad  via the website: EDDIE (Enterprise Data Delivery Information Environment)  
• Web Intelligence Rich Client 

 

BI Launchpad / EDDIE 

BI Launchpad / EDDIE is a secured web-based Business Objects Content Management System 
(CMS) that allows you to create, store, retrieve, view, and print Web Intelligence reports from 
anywhere you have internet access.  
 
The University provides a number of pre-developed, standard reports which are accessed 
through EDDIE by Folders or Categories. We also store our Solution Library reports in EDDIE’s 
Corporate Categories. The Solution Library reports serve as templates for commonly needed 
reports.  
 

Web Intelligence 

Web Intelligence is an easy to use report editor which allows you to create, edit, and analyze 
both simple and complex business intelligence reports. There are two versions of Web 
Intelligence. An HTML version is accessed through the EDDIE website and is run using a 
browser. The Web Intelligence Rich Client is a desktop application which can be accessed 
through EDDIE or from your computer desktop. This training class will focus on Web 
Intelligence Rich Client, but you are free to experiment with the online HTML version.  
 
The major difference between the two versions is that Web Intelligence Rich Client allows you 
to save your documents locally and on network drives. The HTML version can only save reports 
to your Favorites Folder in EDDIE. The Web Intelligence Rich Client is a PC-based application 
and cannot be installed on MAC computers. Since the HTML version is web-based, it can be 
used from MAC computers.  
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Terminology 

The following are terms that will be used in the class: 

Document 
A document is the file created by Web Intelligence. A document can contain multiple queries 
and multiple reports. 

Query 
A query is request for data from a data source. It defines the data content of your report. The 
act of building a query refers to selecting the data to include in your report and then applying 
filters to limit the data returned. 

Data Provider 
The data returned by running a query is stored in the document as a data provider. There can 
be multiple data providers in one document and one data provider can be used in multiple 
reports. 

Report 
A report is any formatted display of data from the data providers. A report can include one or 
more blocks. There can be multiple reports in one document. They are represented as tabs at 
the bottom of the screen. 

Block 
A block is a collection of data in a particular format. In Web Intelligence, the block types are 
table, crosstab, and chart. Multiple blocks can appear in a single report and each block can 
display data from one or more data providers. 

Universe 
A universe is a database interface which maps objects to fields in the database. The universe 
simplifies report creation by eliminating the need to know the database structure. It also 
provides automatic joins between database tables based on key values. 
 

Logging into Web Intelligence from the EDDIE Website 
Web Intelligence Rich Client must first be installed on your computer before it can be used. 
(See Appendix C for installation instructions)  Once installed, the editor must be started the 
first time from the EDDIE website. This downloads a key to your computer. After the key is 
downloaded, the editor can be started from your computer desktop. 
 

1. Open the EDDIE login page: https://eddie.ds.uillinois.edu 

https://eddie.ds.uillinois.edu/
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2. Click the Log in to EDDIE button. 

The University System login page is displayed:  

3. Enter your user name and password and then click the Log On button. 

 Training User Name: dstrainingXX (where XX is 01, 02, .. , 20) 

 Training Password: _______________________ 
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 Note: When you login as yourself, you will use your University NetID and Password to 
access EDDIE.  

The EDDIE Home Page is displayed:  

 
 

Setting Web Intelligence Preferences 
There are two different versions of the Web Intelligence editor. One is web-based and the 
other is desktop-based. You can also just view a document or modify a document. You can use 
either version for viewing and modifying. For this class we will use the Desktop version, Web 
Intelligence Rich Client. You must set your Preferences for the version to use for viewing and 
modifying Web Intelligence documents. 

1. Click Preferences on the EDDIE toolbar. 

2. On the left-hand menu, select the Web Intelligence category. 
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3. Under Modify, select the Desktop radio-button. 

 Note: If you have not yet installed Web Intelligence Rich Client, click the Installation required 
link to begin the installation process. See Appendix C: Installing Web Intelligence Rich Client.  

 

4. Click the Save & Close button in the bottom-right corner of window.  

5. Click OK when you see informational message regarding changes taking effect after page 
reloads.  

 
Launch Web Intelligence Rich Client from EDDIE 
1. Click the Web Intelligence icon under the Applications menu.  

A file will attempt to be downloaded. You must open this downloaded file to access Web 
Intelligence Rich Client.  

2. Click Open 
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 Note: Step 2 might differ depending on your browser and browser security settings. If 
the document is saved to the Download folder, you MUST open the Downloads folder, 
and open the file.  

 
The editor starts and the Web Intelligence Rich Client home page is displayed.  

The Web Intelligence Home Page offers options to create new documents, and to open 
existing documents. The home page provides shortcuts to the most recently used data sources 
and recently opened documents.  
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Web Intelligence Rich Client Options 
There are a couple options in Web Intelligence Rich Client that you may want to change. By 
default, Web Intelligence Rich Client will stay running even after you close it. You have the 
option to have Web Intelligence completely close rather than stay running in the background. 
To have Web Intelligence completely close: 
1. Click the Tools icon in the upper-right corner.  
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2. Select Options from the pop-up menu. 

3. Uncheck the Keep process active after closing last window option. 

 
You also might want to change the unit of measure from centimeters to inches. 

4. Select the Viewing option on the left. 
5. Select the Inch radio button. 
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6. Click OK. 
 

Creating a New Document 
The first step in creating a new document is to select the source for the data. We will use a 
universe for our data.  
 

1. Click 
 

 Note:  A Universe is a database interface which maps objects to fields in the 
database. The universe simplifies report creation by eliminating the need to know 
the database structure. It also provides automatic joins between database tables 
based on key values.  

  
The universe selection window is displayed:  
The universes displayed will limited to the ones you can access. 

2. Select the EDW – STU – Course Schedule universe.  
3. Click Select 
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The Query Panel is displayed: 
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Query Panel 
The Query Panel is used to create the query that retrieves data from the database. The objects 
and filters determine what data is included in the query results. The data returned when the 
query is run is called a data provider, which is stored in the document and becomes the source 
of the data displayed in the report. 

Query Panel parts 

• Universe Outline: displays the objects and filters contained in the universe. They are 
organized by subject in folders called classes. A class can be expanded or collapsed by 
clicking the + or - to the left of the folder. You can also expand/collapse all using the 
buttons located at the top of this panel.  

Expand/Collapse All 
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• Result Objects: contains the objects to be seen in the report. When building a new 
query, each object added to the Result Objects panel is represented as a column in the 
initial report table. 

• Query Filters: contains selection criteria for the query. The query filters determine 
which rows from the database are included in the query results. 

• Data Preview: displays a preview of the data that would be returned if the query was 
run. Click Refresh to update the data. 

Query Panel Toolbar 

 Add Query: Use drop-down menu to select data source for additional queries. 

 Show/Hide Universe Outline panel 

 Show/Hide Filter Pane 

 Show/Hide Data Preview Panel 

 Show/Hide Scope of Analysis Panel 

 Add Combined Query: Two queries on same data source. Join results as a 
union, intersection, or minus. 

 View Script: Shows the SQL select statement produced by the query 

 Runs the query 

Objects 

A universe is a collection of objects, which represent fields in a database table. Object names 
are everyday terms which are easier to understand than the cryptic field names in the 
database. 
Classes   
Classes are logical groupings of objects to make the objects easier to find. For example, all 
address objects might be grouped together in an Address class. 
 

Object Types 

Dimension 
• Dimension objects usually contain text or dates, such as Name, UIN, or Application 

Date. However, some dimension objects may contain numeric data, such as Section 
Enrollment. 

• Dimension objects represent the basic structure of the data. 

 Detail 
• A detail object is always associated with a dimension object. 
• A detail object provides additional information about the dimension object. For 

example, College Description could be a detail object associated with the College 
Code dimension object. 
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Measure 
• Measure objects are numeric values that are the result of calculations. 
• A measure’s value changes depending on the report context. For example, values 

displayed for a Salary object differ if the report is for one pay period or for one 
year. 
 

Finding Objects 

Most of the universes contain a large number of classes and objects, which can make finding 
the objects difficult. You can look for objects by subject by expanding the related class folders, 

or you can search for objects that contain certain words or phrases. 

Adding Objects to the Result Objects Panel 
Once you locate the object to add to your document, there are two ways to add the object to 
the Result Objects panel: 

• Double-click the object. 
• Drag and drop the object to the Result Objects panel. 

We will now create a simple report listing CMN course sections for term 120048. 

1. Enter subject in the filter field.  

The Course Subject Code object will be selected. 
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2. Double-click the Course Subject Code object to add it to the Result Objects panel. 

3. Locate the Course Number object.  

4. Drag the Course Number object from the Universe Outline panel to the right of Course 
Subject Code in the Result Objects panel. 

5. Search for the following objects and add them to the Result Objects: 
Section Number 
Section Enrollment 
Section Building Name 
Section Room Number 

The Section Building Code object is added automatically because it is the dimension object 
for the detail object Section Building Name. We don’t need the building code, so we will 
remove it from the Results Objects panel. 

6. Remove the Section Building Code objects by using one of these methods: 

• Clicking the Remove button on the Panel toolbar 

• Pressing the Delete key on your keyboard 

• Dragging and Dropping it back in the Universe Outline panel 

When you are done the Result Objects panel should look like this example: 

Predefined Query Filters 
Query filters limit the data returned from the database. Filters are vital when running queries 
against a large database. If the query runs without filters, the query could run for hours and 
return millions of rows. There are two types of query filters: predefined and user-defined.  
 
Query filters allow you to:  

• Retrieve only the data you need to answer a specific business question  
• Minimize the quantity of data returned to the document to optimize performance 

 
Predefined query filters are time savers that are included within the universe. They are created 
for filters that are complicated and/or commonly used. Predefined query filters save time 
because they can just be added rather than having to create the filter yourself. 
 
Predefined filters are in indicated in the data window with the  icon. 

There are two ways to add a predefined filter to the Query Filters panel: 
• Double-click the filter. 

Remove 



Chapter 1: Creating a Basic Report 21 

• Drag the filter to the Query Filters panel. 

1. Clear your search box by clicking the X  

2. Expand the Conditions class by clicking the box with the + symbol. 

3. Double-click the Current Section Enrollment filter to place it in the Query Filters panel. 

This filter will limit the results to only the most recent value for the enrollment for a 
section. 

4. Expand the Prompts class. 

5. Double-click the Select Term Code filter to add to the Query Filters panel. 

This filter includes a prompt, which will allow you to enter the value(s) for the Select Term 
Code filter when the query is run. 

6. Double-click the Select Course Subject Code filter to add to the Query Filters panel. 

This filter will prompt you to enter a Course Subject Code to be included in the report. 

The Query Filters panel should look like this example: 

Running the Query and Entering Prompt Values 

1. Click the Run Query button. 

Since our query contains prompts, the Prompts Window is displayed: 

Clear Search 
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2. Click the Select 6 Digit Term Code prompt in the Prompt Summary.  

 

 Note: The first time the list of values for an object are displayed, all values are 
retrieved from the database and stored in a file on the hard-drive, which can take some 
time. However, the next time you see the same list, the values will be read more 
quickly from the local file. 

 
There are two methods for entering a prompt value:  

• Select from the list of values 
• Manually type a value in the “Type a value” box  

 

 Note: If you choose to use the Type a Value box, you must type the value exactly as it 
appears in the database. Values are case-sensitive.  

 
7. Select 120158 from the list of values.  

This will show results from Urbana 2015 Fall Semester 
8. Click the  button to move the value into the selected value(s) box.  

9. Click Select Course Subject Code prompt in the Prompt Summary. Wait for the list of 
values to populate.  

10. Type CMN in the search pattern field and click Enter. 

 Note: If you enter the value manually in the Type a value field, make sure to type it 
correctly; otherwise, you will get no data. Remember that the values are case-
sensitive.  

 

11. Double-click the value CMN to add to Select Course Subject Code list.  
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The Prompt Window should look like this example: 

12. Click the OK button to run the query.  

 

Report Manager Window 
Once your query has run, the report will be displayed in the Report Manager window. This 
window has many toolbars and tabs that contain the various features available in Web 
Intelligence.  

View Mode 

In the upper-right corner you will see 3 view modes: Reading, Design, and Data.  
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Reading Mode: This is a view-only mode. Report features are not available in this mode.  

Design Mode: Offers reporting features and the ability to make changes to report formatting.  

Data Mode: Shows query information such as data source and number of rows returned. (only 
available in the Rich Client version) 
 

Saving a Web Intelligence Document 

1. On the File tab, click the Save menu icon.  

2. Select Save as 

The Save Document dialog box is displayed: 

3. For File name: enter Section Enrollment. 

4. Check the Save for all users and Remove document security check-boxes. 

Save for all users allows other people to open the document. 
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Remove document security disassociated the document with a particular Business Objects 
environment. This is not normally needed, but it does help to prevent a document from 
being removed as an email attachment. 

5. Click the Save button. 

The file will be saved to the userDocs folder with that name and an extension of .wid 
 

Changing Default Save Location 

By default, all documents will be saved to the userDocs folder under My Documents\My SAP 
BusinessObjects Documents folder. You can change this to another location if you wish.  

1. In the upper-left corner, click the Properties tab. 

2. Select Application.  

3. Under the General settings, in the Select Default Folders section, click Browse next to the 
User documents: location 

4. Browse to the folder where you want to save your Web Intelligence documents. 

5. Select the desired folder, and click Open.  

6. Click Ok to exit Application Properties.  

 

Document Toolbar 

 Undo: Undo last action(s). 

 Redo: Redo an action that was undone.  

 Delete: Deletes the selected report element(s).  

 Edit Query: Opens the Query panel to make changes to the query.  

 Refresh Data: Refreshes the report data and/or change Prompt Values.  
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Page Navigation 

By default, Web Intelligence paginates results every 100 rows. To see all results, you may need 
to use page navigation, located at the bottom of your report window: 

Closing Web Intelligence  
1. Close Web Intelligence by clicking the X in the upper right corner of the program window.  

 

 

 Note:  If you haven’t changed the “Keep process active after closing last window” 
option, Web Intelligence will continue to run in the background. If you do not use 
the program for 60 minutes, the connection will time-out.  

 

Disconnecting from the Server 

If Web Intelligence is still running in the background and you want to truly close Web 
Intelligence, you can quit the program from the running programs list on your computer’s task 
bar.  

1. Click on the  button on the lower-right corner of your task bar to show all running 
programs.  

2. Right-click on the Web Intelligence icon and select Quit. 

Your connection to the Web Intelligence Server has now been terminated.  

 

Close Web Intelligence 

Close document 
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Starting Web Intelligence from Desktop 
You can start Web Intelligence from the Windows desktop after it has been launched initially 
from EDDIE. 

Open SAP Business Objects Web Intelligence: 

1. From the Windows Start menu, click All Programs. 

2. Select SAP Business Intelligence.  

3. Select SAP Business Objects Web Intelligence. 

The Web Intelligence Home Page is displayed. Note the connection status is Disconnected:  
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Logging into Web Intelligence 

Notice when you first open Web Intelligence, the connection status will show Disconnected. 
Before you can open and run reports, you must first login and connect to the Business Objects 
server. 

1. Click the Web Intelligence drop-down menu. 

2. Select Login as. 

The User Identification window is displayed: 

3. Enter your Training Account Login Credentials: 

User Name: dstrainingXX (where XX is 01,02,…,19) 

Password: _____________________ 

4. Change the Authentication field to Enterprise. 

 

 Note:  When you log in using your personal account, use the LDAP Authentication 
type and your Windows password. The training accounts aren’t set up the same as 
personal accounts, so LDAP isn’t an option. 

5. Click Log On. 
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The connection status now shows Connected. 
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Exercise 1: Creating a Basic Report 

Review 

1. A ____________ is an interface which maps objects to data in a database. 

2. What are the three types of objects? 

3. What are the two methods of adding objects to the Result Objects panel? 

4. Describe the icon for Predefined query filters. 

Exercise 

1. Create a new document using the DM – STU – Section Capacity universe. 
2. Display the following objects: 

• Term Code 
• Course Subject Code 
• Course Number 
• Course ID 
• Course Title 
• Section Number 
• Section Enrollment 
• Section Avail Seats 

3. Add the predefined filters: 
• Active and Gradable 
• Prompt for Term Code 
• Prompt for Course Subject Code 

4. Run the query and enter these values for the prompts: 
• Term code: 120158 
• Course Subject code: ENGL 
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The top of the table should look like this: 

5. Save the document as Available Seats. If a document with this name already exits, 
overwrite it. 
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Chapter 2: User-defined Query Filters 

Open Document 
1. Click the Section Enrollment document from the Recent Documents list. You can also 

select Open to locate the document. 

Adding Objects to Existing Query 
Most reports require changes to the data after the query is run the first time, such as removing 
or adding objects. Selecting the Edit Query button on the Standard toolbar displays the Query 
Panel where you can make changes to the query. 
 
We will now add the Instructor Last Name, Meeting Days, and Start - End Time to our query: 

2. Click the  button to display the Query Panel. 

3. Expand the Instructor class. 

4. Locate the Instructor Last Name object. 

5. Double-click the object to add it to the result objects. 

6. In the Search box, enter Meeting Days. 

7. Double-click Meeting Days to add it to the result objects. 

8. In the Search box, enter Start Time. 

9. Double-click Start Time — End Time to add it to the result objects. 

The Result Objects panel should include these objects: 

10. Click Run Query. 

11. When the prompt window is displayed, click OK to keep the same prompt values. 

12. The report is displayed and the new objects are shown in the available objects list: 
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Adding a New Object to a Table 
Although the new objects have been added to the query, they are not automatically added to 
the table. You must add the columns to your table from the Report Manager window. Columns 
can be added to a table using the drag and drop method. Drag the object you want to add to 
the table from the Data Manager, and drop the object into the table where you want to add it:  
 

 To add the object into a new column to the left of an existing column, drag the 
object onto the left edge of any cell in the column. 
 

 To add the object into a new column to the right of an existing column,  
drag the object onto the right edge of any cell in the column.  
 
To replace an existing column with the new column, drag the object over the 
center of any cell in the column. 
 
The new column will copy the formatting of the column that you drop the 
object on. 

1. Select the Instructor Last Name object from the list of Available Objects. 

2. Drag and drop the object to the far right side of the Section Room Number column header. 
You will see a small blue rectangle on the right side of the cell.  
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The Instructor Last Name data is added as a column in your table.  

3. Drag and drop the Meeting Days and Start Time – End Time objects into the table as 
shown:  

User-defined Query Filters 
As we learned in Chapter 1, filters are added to a query to limit data returned from the 
database. If there are no predefined filters in the universe that will give you the desired data, 
you can easily create your own user-defined query filter. A filter contains three elements:  

• Object:  What to compare 

• Operator: How to compare it 

• Operand:  What to compare it to 

 
We will now add a query filter to limit the results to sections with enrollment greater than 
zero. 

1. Click the  button to display the Query Panel window.  
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2. Drag and drop the Section Enrollment object to the bottom of the Query Filters panel. 

The new query filter for Section Enrollment is created. 

3. Click the drop-down arrow next to In List, and select Greater than from the list of 
operators. (See Appendix D for a description of each operator option.) 

4. Enter 0 in the Type a constant text box. 

 Note: You can also select the operand menu button  for other options for entering 
the Operand, including Selecting Values from List and creating a Prompt.  

Your filter should now look like this: 
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Operators 
In list returns multiple values. Separate the values with semi-colons 

with no spaces 
Not in list returns all value except those in the list 
Equal to returns a single value 
Not Equal to excludes a single value 
Greater than returns values greater than the specified value 
Greater than or Equal to returns values greater than or equal to the specified value 
Less than returns values less than the specified value 
Less than or Equal to returns values less than or equal to the specified value 
Between returns all values between or equal to the specified values 
Not Between returns all values outside the specified values 
Is null returns null values 
Is not null return non-null values 
Matches Pattern returns values matching the specified pattern including 

wildcards: _ for a single character; % for any one or more 
characters 

Different From Pattern returns values not matching the pattern 
 

No Data to Retrieve 
When working with filters, it is possible to create a situation where all rows are filtered out. 
When this happens, you will receive the following message: 

This means that there is no data to fetch from the database. Usually, this means you need to 
fix a problem with your query filters. Some reasons this may happen include:  
 

• Entering a bad value for a prompt or filter. If you manually entered values in the Type 
a Value box, try removing the values, and selecting from the list.  
 

• Creating two filters that are contrary to each other, for example requesting Section 
Enrollment greater than 0 and less than 0 in the same query. 
 

• Requesting data to which you do not have security access. For example, entering a 
program code that is not in your deparment, or requesting college-level data when 
you are a department-level user.  
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Grouping Filters using the And / Or Logical Operator 
Web Intelligence permits the creation of complex query filters in which filters can be grouped 
together. Complex query filters are created by grouping and connecting filters with logical 
operators. 
 

• The And operator requires that both filters be true for the row to be included in the 
query.  

• The Or operator requires that only one of the filters be true for the row to be returned 
in our query results.  

 
We will further refine our search by including sections that have an instructor assigned, even if 
the enrollment is zero by using the Or operator.  

1. Locate the Instructor Last Name object and drag it to the bottom of the Query Filters 
panel. 

Notice that all of the filters are connected with an And operator. This means all conditions 
have to be true. 

2. Select the Is not null operator from the drop-down list.  

 

 Note:  The “Is not null” operator returns only rows that have a value in the Instructor 
Last Name field.  

 

3. Drag the Instructor Last Name filter box, and drop it on top of the Section Enrollment 
filter box. 
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4. Click the And operator that joins the Section Enrollment and the Instructor Last Name 
filters. The operator will change to Or. 

5. Run the query using the same prompt values. 

On page 2 of the report, you will see rows that have an enrollment of 0. They were 
included in the data returned because the instructor name is not null. 

6. Save the document. 

7. Close the document. 
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Exercise 2: User-defined Query Filters 

Review 

1. What icon allows you to edit the query? 

2. How many parts are there in a user-defined query filter? 

3. What is the difference between the And and Or operators? 

Exercise 

1. Open the Available Seats document created in Exercise 1. 
2. Add query filters to limit the data to rows where Course Title contains either the word 

American or the word British. 
3. Run the query. 

The table should look like this: 

4. Save the document. 
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Chapter 3: Prompts 

A prompt is a Query Filter where the operand can be entered each time the report is 
refreshed. Creating a query filter with a prompt allows the user to retrieve different data from 
the database without changing the filters, making the report more flexible. Each time you run 
a query with a prompt, you will be asked to supply the value(s) to limit the data. 
 

Building a Prompt 
We will now create a prompt that will allow us to filter our results to just show certain Course 
Number Levels.  

1. Open the Section Enrollment document. 

2. Edit the query by clicking the   button. 

3. Type level in the search box. Locate the Course Number Level object and drag it to the 
bottom of the Query Filters panel. 

4. Leave the operator value as In list (default value) 

The In list operator is similar to Equal to, but it allows you to provide a list of values rather 
than a single value. 
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5. Click the Operand menu button  and select Prompt. 

The filter should look like this example:  

6. Click the Prompt Properties  button.  

The Prompt Properties dialog box is displayed: 

Prompt Properties 

Prompt with List of Values When a prompt is selected, a list of values is generated. This list 
can be disabled if the list of values is large and takes too much 
time to populate. 

Select only from list Removes the Enter a Value field in the prompt window. Values 
must be selected from the list of values.  

Keep last values selected Saves the value(s) entered the last time the query was run.  
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Optional prompt User can choose to not enter a value for prompt. If a value is not 
entered, the filter will be not be applied to the query.  

Set default values Allows you to select default values. User can modify this value at 
prompt.  

7. Check the Optional prompt check box.  

8. Click   

9. Click  

10. Select the Enter value(s) for Course Number Level prompt.  

11. Click  to refresh the list of values 

The List of Values of Course Number Level object is displayed. 

12. Select 100, 200, and 300 from the list.  

 Note: You can select a value from the list in two ways:  Double-click the value or single-
click the value and then click the > button. 

13. Click  
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The report now only includes courses with numbers in the 100s, 200s, and 300s:  

 

Refresh Data / Changing Prompt Values 
Since the query includes prompts, you can change or update the data by refreshing. We will 
now refresh the data for the document. 

1. Click   to refresh the report. 

2. In the Selected Values panel, click on the 120158 Term Code value.  

3. Click the < button to remove the current Term Code  

4. In the Type a Value panel, enter 120168 and press Enter (or click the > button).  

5. Leave Course Subject Code as CMN 
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6. Add 400 to the list of course level numbers. 

7. Click  to run the query. 

When the data is refreshed, the most recent data is displayed in the report. 

8. Click  to save the changes to the document. 

 

Displaying Prompt Responses 
The values entered at prompts determine what data is included in the report. This is important 
information and should be displayed in the report. Instead of including the object as a column 
in the table, which may have all the same values, it is better to display the responses in the 
report header. We will add text cells as labels and then the prompt responses. 
 

1. Move the mouse cursor over the table border until the cursor changes to a four-headed 
arrow. 

2. Drag the table down about half an inch to allow for one line of text between the title and 
the table. 

3. Select the Report Element tab. 

4. Select the Cell subtab. 
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5. Click the Blank option. 

6. Move the mouse cursor onto the report. The cursor is now a +. When you left-click, the 
upper-left corner of the new blank cell will be placed at that location. 

7. Click above the table near the left edge to set the location for the new blank cell. 

A text entry field is displayed. 

8. Double-click the new cell. 

9. Enter Term: as the text for the new cell and click the green check to save the change. 

10. Resize the cell by dragging the box on the right edge to make the cell just wide enough for 
the text. 

The cell should look like: 

11. Select Pre-Defined from the Cell menu. 

12. Select Prompt. 

13. Select Select 6 digit Term Code. 

14. Place the cell just to the right of the cell with the “Term:” text. 

15. Repeat the steps for the Course Subject Code and Course Level prompt values. 

When completed the top of the report should look something like: 

16. Save the document. 

17. Close the document. 
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Exercise 3: Prompts 

Review 

1. When are the prompts displayed? 
2. When entering multiple values for a list, what separator should be used? 
 

Exercise 

1. Open the Available Seats document. 
2. Add an optional prompt for a minimum Section Avail Seats value. 
3. Run the query and enter 10 for the minimum available seats. 

The table should look something like this: 

4. Refresh the document and remove the value for the minimum available seats. 
5. Display the selected prompt values at the top of the first page of the report. 
6. Add Instructor Last Name to the table between Section Number and Section Enrollment. 

The report should look something like this: 

7. Save the document. 
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Chapter 4: Formatting 

Formatting of a report takes place after the query has been run and the results are displayed in 
the Report Manager. Do not assume that a report has to look like what is displayed by default. 
You have complete control over the look of the report. This chapter will show some of the 
ways to format the report. Formatting can be done at several levels including, report, section, 
break, table, and cell. 
 

Report Formatting 
Display Modes 

Web Intelligence offers two display modes for reports: Quick Display Mode and Page Mode. 
Quick Display mode is the default. It displays the report as a continuous page with no margins. 
Page mode will display the reports as they will look when printed, like Print Preview. We will 
change to Page Mode. 

1. Open the Section Enrollment document. 

2. Click the Page Setup tab at the top of the editor.  

3. Click the Display subtab.  

4. Click on   button.  

 Note: You can also switch to Page Mode using the icon on the status bar located at the 
bottom of the editor. 

The report is now displayed in Page Mode. 
 



50 Web Intelligence Reporting Basics 

Paper Size 

The paper size used for the report will determine how the report is paginated. If you find 
yourself changing the paper size for every report, you may want to change the default style 
sheet. The default paper size is one of many settings defined in the style sheet. You can either 
export a style sheet with the settings you want so that you can import it into another report or 
change the default style sheet. (See Appendix F for instructions on changing the default style 
sheet.) 

1. Select Page Setup tab. 

2. Select the Page subtab. 

3. Select Letter as the paper size to use. 

 

Changing Margin Sizes 

In order to fit larger tables in your report, you may have to adjust the margin sizes of your 
document.  
1. Click the Page Setup tab. 
2. Click the Margins subtab. 
3. For each of the four margin settings, delete the current setting, and type the desired size. 

For our example, we will change the margins to all be .5 “ 
4. Press Enter after you type each value. 

 Note: If margins are showing in Centimeters, you can change to inches by selecting 
Properties > Application > Viewing. Change the default measurement unit to inches. 
The cm equivalent to .5 inches is 1.27 cm. 
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Apply Scale to Page 

Scale to Page allows you to specify the number of pages wide and high you want your report 
to fit on.  

1. Click the Page Setup tab. 

2. Click the Scale to Page subtab 

3. In the Height drop-down box, select 1 Pages 

The table is scaled so that it fits on the first page. 

4. Reset the Height to Automatic. 

5. Make sure the orientation is set to Portrait. 

Page Numbers 

There are pre-defined cells for page numbers in the Report Element > Cell tabs. The three 
options are: 

• Page Number 
• Page Number/Total Pages 
• Total Number of Pages 
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Table Formatting 
Removing a Column 

After running a query you may decide that you no longer need a column to appear in the 
finished report. We are going to remove the Course Subject Code column from the table, since 
it is displayed above the table. 

1. Right-click in the Course Subject Code column. 

2. Select Delete. 

Rearranging Columns 

One way of moving columns within Web Intelligence involves dragging and dropping a column 
to the desired location. Moving columns allows you to modify the way the data is presented 
after running the query.  

1. Click on any cell in the Section Enrollment column. The column is highlighted.  

2. Drag the column to the right edge of the Instructor Start Time – End Time column. Drop it 
when you see the blue rectangle on the right edge of the column. 

The table should now look like: 
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Displaying Table Headers at the Top of Each Page 

By default, the Table Header only shows at the top of the first page. You can display the 
header row at the top of each page: 
 
1. Click on the border of the Report 1 table.  

2. Click on the Report Element tab.  

3. Click on the Behaviors Subtab.  

4. Select Repeat > Headers on Every Page.  

If you look on page 2, the table will now have the column headers. 

 

Cell Formatting 
Wrap Text 
If your object names are too wide for the width of the cell in the table header row, you can 
turn on Wrap Text.  

1. Click the Format tab. 

2. Click in the Course Number header cell.  

3. Hold down Shift key and click the last header cell to select all header cells.  

4. In the Alignment subtab, select the Wrap-text icon  

The text in the header row is now wrapped: 
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Resizing Column Widths 

1. Double-click on the right border of the Course Number column (Auto-size) or drag the 
right column border and drag to desired width.  

2. Resize all columns to desired width. 

The table should look something like this: 

 

Formatting Numbers 

You can change how values display in specific cells or columns on your table. The default, 
number formats are defined for the object in the universe. You can change this format to 
another predefined format, or you can apply custom formats to the data in your table. In this 
class we will focus on the predefined number formats.  
1. Right-click on any cell within the Section Enrollment column. 

2. Select Format Number from the pop-up menu. 

3. Select the Number format type. 



Chapter 4: Formatting 55 

4. Select the 1234.57; -1234.57 format. The format samples show the format for positive and 
negative numbers. 

 Note: Custom formats allow you to define your own formats for positive, negative, zero, 
and undefined values. 

 

5. Click the Apply button to see the change without exiting the dialog box. 

The numbers in the Section Enrollment column are displayed with 2 decimal places. 

6. Click the Cancel button to exit the dialog box without saving the change. 

7. Save the document. 
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Exercise 4: Formatting 

Review 
1. What menu item do you select to change the report margins? 
2. You can only wrap text in the column headings. True / False? 
 

Exercise 
1. Open the Available Seats document. 
2. Change to the Page Layout view. 
3. Change the page size to Letter. 
4. Change the margins to 0.5 inches on all sides. 
5. Remove the Term Code and Course Subject Code columns from the table. 
6. Wrap the text in the column headings and in the columns as needed. 
7. Resize the columns to fit the table on one page. 
8. Right-align the header for Section Enrollment and Section Available Seat. 
9. Have the table header display on each page. 

The table should look something like: 

10. Save the document. 
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Chapter 5: Report Analysis Features 

In this chapter, we will cover four features that can help you analyze the data in your reports:  
Sorting, Filtering, Breaks, Sections, and Calculations.  
 

Duplicating and Renaming a Report 
It is good practice to first make a copy of a report before making major modifications. That 
way you have original if the changes don’t work out. Each report within a document has its 
own tab at the bottom of the editor. Next, we will create a duplicate the first report so that we 
can save different variations of the report. 

1. Open the Section Enrollment document. 

2. Right-click the Report 1 tab in the bottom left corner of your report window.  

3. Select Duplicate Report. 

An exact copy of the report named Report 1 (1) is added to the document and is now the 
active report.  

4. Duplicate Report 1 (1). This will create another report named Report 1 (2) 

5. Right-click the Report 1 (1) tab and select Rename Report from the menu. 

6. Type Enrollment by Instructor and press Enter. 

Later, we will sort this report by instructor last name. 

7. Double-click the Report 1 (2) and enter a new name of Armory and press Enter. 

8. Rename Report 1 to Enrollment by Course Number. 

You should have three report tabs with the following names. 
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 Note:  Notice when you rename the Report tab, the report title automatically updates.  

 

Applying a Report Filter 
After running a query, you may decide that you want only certain data to be displayed in your 
report. For example, if you have data for your college, you may want to have a report for each 
department. Applying a report filter allows you to run a single query with all the data you need 
to produce a number of reports. In our case, we only want to show data for the sections held 
in the Armory. 

1. Click the Armory report tab. 

2. Click on any value in the Section Building Name column. 

3. Select the Analysis Tab, then the Filters subtab.  

4. Click  Filter.  

 Note:  You can also right-click the column, then select Filter > Add Filter.  

The Report Filter dialog box is displayed:  

5. Double-click on Armory in the list of values 

6. Click OK to apply the filter. 
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The report now displays only data where the Section Building Name is Armory. Additional 
filters could be applied to further limit the rows displayed.  

 

 Note:  To remove the filter, select the filtered column, click the arrow to the right of 
the Filter    icon and select Remove Filter.  

7. Right-click on the Armory tab and select Delete Report from the menu to remove the 
Armory report. 

 

Inserting a Break 
In our example, we would like to display the sum of students enrolled not only in each section, 
but also a sub-total by Course Number. First we will insert a break on Course Number. Inserting 
a break will take a large table of data, and create “sub-tables” to make the information easier 
to understand.  

1. Select the Enrollment by Course Number report. 

2. Click anywhere in the Course Number column. 

3. Click the Analysis tab  

4. Click the Break > Add Break 

 

 Note:  Breaks can also be added by right-clicking the desired column, and selecting 
Break > Insert Break from the pop-up menu.  
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5. Click Next Page to page 3 to see the breaks on the table. 

Breaks have a header with the column headings and a footer with the calculations, such as 
sum or count. The display of the header and footer can be controlled in the Manage 
Breaks option. 

 

Sorting Data in a Table 
Even if no sorting has been applied, the table is sorted by default. The dimension and detail 
objects are sorted from left to right in ascending order. Measure objects are not sorted by 
default. We will now override the default sorting by specifying the sort order for some 
columns. 
 

Inserting Sorts 

The default sorting is in effect, so the table is sorted by Course Number in ascending order first. 
Within Course Number, the table is then sorted by Section Number in ascending order. Within 
Section Number, it is sorted by Section Building Name. And so on. We will now sort the table 
by Section Enrollment in descending order.  

1. Select the Enrollment by Course Number report. 

2. Select the Section Enrollment column by clicking any value in the body of the column.  

3. Select the Analysis tab, then Display subtab. 
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4. Click the Sort drop-down menu.  

5. Select  Descending. You may need to navigate back to page 1 after adding sort. 

 Note: You can also right-click in the column and select Sort > Descending from the 
right-click menu.  

 

Within the break, the table is now sorted by Section Enrollment in descending order. 
Within Section Enrollment, the default sorts are still applied as shown below. 

Now we will apply a secondary sort to the Section Building Name column using the right-
click menu option:  

6. Right-click anywhere in the Section Building Name column.  

7. Select Sort from the menu. 

8. Select  Ascending. 

 

 Note:  A second sort may not make a major change to the order of the rows because it only 
affected rows with the same value of the first sort. 
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Managing Sorts 

The Advanced option in the sort menu allows you to add, edit, and remove sorts, as well as 
change the priority of the sorts. We will change the sort priority to sort first on Section Building 
Name, and next on Section Enrollment.  

1. Click anywhere in the table.  

2. Select the Analysis tab, then Display subtab. 

3. Click the Sort drop-down menu.  

4. Select Advanced. 

5. Click Section Building Name, which is the bottom sort. 

6. Under Priority, click   to make the sort on Section Building Name the first sort. 

7. Click OK. 

8. Use page navigation to return to page 1 

Section Building Name is now the primary sort, and Section Enrollment is the secondary 
sort, all within the break value for Course Number. 
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Inserting Calculations 
Web Intelligence calculations enable you to quickly add information to your report. Many of 
the calculations only work with numeric data. The type of data determines which calculation 
functions are available. 
 

The following table shows the available calculations and data types: 

Calculation Object Type Description 
Sum    Calculates the sum of the selected data. 

Count   Counts distinct rows. 

 Counts all rows. 

Average   Calculates the average of the data. 

Minimum   Displays the minimum value of selected data. 

Maximum   Displays the maximum value of selected data. 

Percentage    Displays each row’s percentage of the total. 
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Inserting a Sum 

The Sum calculation adds the values in a column. 

1. Right-click the Section Enrollment column. 

2. Select Insert > Sum. 

 Note: Calculations can also be found on the Analysis tab, under the Functions subtab.  

The sum of the Section Enrollment values is added for each course number. The name of 
the calculation is added to the previous column, if one exists. 

 

Sections 
Sections are like breaks in that they divide the report into parts. Sections have the added 
feature of working as a navigation tool. Also, when a document is saved as a PDF, the sections 
become bookmarks in the PDF. 

1. Select the Enrollment by Instructor report. 

2. Right-click in the body of the Instructor Last Name column. 
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3. Select Set as Section from the pop-up menu. 

The report will be divided into sections, one for each Instructor Last Name value. One of 
the advantages of sections is that they can be used as a navigation tool. 

4. Click the Report Map icon at the left edge of the editor. 

5. Click the + to the right of Enrollment by Instructor to expand the list. 

6. Click on any value in the list to go to that part of the report. 

The sections are converted to bookmarks if the document is saved as a PDF. 

Sections have formatting options, which can be accessed by right-clicking the section and 
selecting Format Section from the pop-up menu. 

7. Save the document. 

8. Close the document. 

  



66 Web Intelligence Reporting Basics 

Exercise 5: Report Analysis Features 

Review 
1. What menu item do you select to change the report margins? 
2. You can only wrap text in the column headings. True / False? 
 

Exercise 
1. Open the Available Seats document. 
2. Create a duplicate of Report 1. 
3. Rename the new report to Available Seats by Course. 
4. In the new report, add a break on the Course Number column. 
5. Add a descending sort on the Section Available Seat. 
6. Add a Sum calculation to the Section Enrollment and Section Available Seat columns. 
7. Move the title to the report header. 
8. Add page numbers to the right edge of the report header. 

The reports should look something like:  

9.  Save the document. 
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Chapter 6: Saving and Sending 

In addition to saving a document in the standard file type (.wid), you can also save the file in 
different formats such as Excel, PDF, CSV, or Text. It is a good practice to save your report first 
as a Web Intelligence document, and then to save your results to Excel or PDF each time you 
refresh the report.  
 

Save as Excel  

1. On the File tab, click the Save menu icon .  

2. Select Save as 

3. In the Files of Type drop-down, select Excel (.xlsx). 

4. Select a location on your computer to save the file. We will select Desktop. 

5. Click the Save button. 
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6. Open the .xlsx file through Excel. 

Notice the some of the formatting from the Webi document is maintained in the 
spreadsheet. 

7. Close the Excel file and return to Web Intelligence. 

 

Save as PDF 

Adobe Acrobat Reader has fairly extensive controls for viewing and printing reports. 

1. On the File tab, click the Save menu icon.  

2. Select Save as. 

3. In the File of Types drop-down menu, select PDF. 

4. Deselect the Armory report.  

Each report will be saved with its own bookmark in the PDF.  

5. Click Save. 

 

Save as CSV 
If you only want the data from the data provider, with no formatting, you can export the data 
to a CSV (Comma Separated Values) file. This is different than saving the report to an XLSX file 
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because the report may have had filters and sorts applied. The Export Data option exports the 
data provider, not the table(s) in the report. 

1. Select the Export Data option in the File tab. 

The Save Document dialog box is displayed. 

Notice there are no reports listed because this option is exporting the data in the data 
provider. CSV is the only file type available. 

2. Click Save.  

Saving Documents to EDDIE 

Web Intelligence allows you to save your reports to your Favorites folder in EDDIE. Reports 
saved to EDDIE can be viewed and refreshed from any computer through our secured Business 
Objects environment. Some advantages to saving reports to EDDIE include: 

• Documents are stored in a safe and consistent location for long-term storage of completed 
documents or templates. 

• Documents can be viewed easily from any location through the EDDIE website.  
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• Documents can be sent to other Business Objects user’s Inboxes. 

• Documents can be scheduled to run automatically with the Schedule option.  

1. On the File tab, click the Save menu icon.  

2. Select Save to Enterprise. 

The Save Document window is displayed: 

3. Select the My Favorites folder. 

 Note:  You can also select a sub-folder or create a new folder by clicking the  icon. 
4. Save the document. 

5. Close the Document. 

 

Opening a Document from EDDIE from your Desktop 

To retrieve the document from EDDIE (including our Solution Library documents). 

1. From Web Intelligence Rich Client home page, click the File Open   drop-down menu.  

2. Select Open From. 
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The Open Document from Server window is displayed: 

3. Select the Section Enrollment document. 

4. Click the Open button.  

 

Sending a Document via Email 

Make sure you have checked the Save for All Users and Remove Document Security prior to 
sending by email.   

1. Open the Section Enrollment document. 

2. Click Send by email attachment  drop-down menu.  

3. Select Web Intelligence Doc (.WID) for the document type to send.  

 Note:  You can also choose to send as the document in Excel or .PDF formats.  
4. Your default email application appears with the Web Intelligence document inserted as an 

attachment. 

5. Close the document. 

6. Close Web Intelligence. 
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 Note:  Sometimes our University mail servers will not accept the .WID file type, and it will 
quarantine the email message. If this happens, do not use the Email feature in Web 
Intelligence. Rather, compose the message in Outlook and attach the file using the 
Outlook attach file feature.  
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Appendix A: Additional Assistance 

Decision Support Website  

Additional resources and online help can be found on the Decision Support website. Resources 
include user guides and quick tips on using both Web Intelligence and EDDIE.  

https://www.aits.uillinois.edu/services/reports_and_data/help_and_training/ 

 

AITS Service Desk 

For further assistance, or to report a problem, contact the AITS Service Desk: 

Email:          servicedeskaits@uillinois.edu 

Chicago:   (312) 996-4806 

Urbana & Springfield:   (217) 333-3102 

 

SAP Web Intelligence Online Help 

Web Intelligence provides on-line assistance and information about basic product features, as 
well as information to help you troubleshoot and solve common problems. 

Click the  in the upper right corner of the Web Intelligence window.  

 

Help Contents 

This will take you to the SAP Web Intelligence online help.  

Tutorials 

This options is not enabled at this time and will take you to the main SAP website. SAP does 
have a limited amount of video tutorials located on their YouTube Channel.  

About Web Intelligence 

This contains version and licensing information. 

https://www.aits.uillinois.edu/services/reports_and_data/help_and_training/
mailto:servicedeskaits@uillinois.edu
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Appendix B: Installing Web Intelligence 

In order to install Web Intelligence, you need to:  
• have administrative rights to the machine 
• disable popup blockers 
• open firewall ports 
 

Installing the Web Intelligence Rich Client 

The SAP Business Objects Web Intelligence installation is available for online download 
through the Preferences screen in EDDIE.  
 
1. Login to EDDIE using your Business Objects credentials: 

https://eddie.ds.uillinois.edu/ 

2. Click on the Preferences menu 

3. Select Web Intelligence from the left side menu. 

4. Under Modify, select Desktop 

5. Click the Installation required link to begin installation.  

Full installation instructions can be found on our web page:  

https://www.aits.uillinois.edu/common/pages/DisplayFile.aspx?itemId=199454 

https://eddie.ds.uillinois.edu/
https://www.aits.uillinois.edu/common/pages/DisplayFile.aspx?itemId=199454
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Appendix C: Query Filter Operators 

The following table helps you to select the operator you need: 
 

Operator Description Example 
Equal to Is equal to one given value Year Equal to 2005 
Not Equal to Is different from, or not equal 

to, one given value 
Employee Status Code Not 
Equal to T 

Greater than Is greater than a given value GL Detail Credit Amount 
Greater than 100 

Greater than or Equal to Is greater than or equal to a 
given value 

GL Detail Credit Amount 
Greater than 100 

Less than Is less than a given value Job Detail Annual Salary Less 
than 20000 

Less than or Equal to Is less than or equal to a given 
value 

Employees who are 60 or 
under 

Between Is greater than or equal to the 
first given value and less than 
or equal to the second given 
value 

Job Begin Date Between 
1/1/2004 12:00:00 AM and 
12/31/2004 11:59:59 PM 

Not Between Is less than the first given value 
or greater than the second 
given value 

Employee Age Not Between 
18 and 60 

In list Is equal to any of a list of values Employee Campus Address 
Code In list (C1;C2) 

Not in list Is different from all of a list of 
values 

Employee Detail Department 
Code Not in list 
(103;714;715) 

Is null Contains empty rows Employee Campus Email 
Addr Type CD Is null  

Is not null Does not contain empty rows Employee Campus Email 
Addr Type CD Is not null 

Matches pattern Contains the same character(s) 
as the given pattern. Wildcard 
characters are _ for a single 
character and % for 0 or more 
characters. 

Employee Last Name 
Matches pattern S% 

Different from pattern Does not contain the same 
characters as the given pattern 

Financial Account Code 
Different from pattern 9% 

Both Satisfies two conditions on one 
object 

Prior Degree Year Both 
2001;2004 

Except Excludes a given value Employee Status Code 
Except T 
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Using In list 

You can type your list of values in the text field of the Type a constant text box. If you click the 
Operand button, you can also select Value(s) from list to select from a list of values. The 
maximum number of values allowed in a list is 256.  
When entering multiple values manually, use a semi-colon (;) to separate each value.  
 

Using wildcard characters 

Conditions with the Matches pattern and Different from pattern operators are great for finding 
lists of similar values, such as customer names beginning with S. 
 

Wildcard Description 

%  Replaces several characters, or in the response to a prompt. 
For example, N% returns all values beginning with an N (New York, Nevada, etc.) 
 

_ The underscore character (_) replaces a single character in a constant. 
For example, GR_VE returns Grave, Grove, Greve, etc. 
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Appendix D: Query Filter Operand Options 
 
The following table helps you select the operand option you need: 
 

Operand Option Description Enter by… 
Constant Values that you type. 

Note that values are case-
sensitive and must be entered 
exactly as they appear in the 
database otherwise no data 
will be returned. 
 

Type the values with a 
separator (semicolon) 
between each one.  
 
 

Value(s) from list Values that you select from 
the object’s list of values 

Select Value(s) from list 
option. Select from the 
populated list of values. Click 
Refresh values if list does 
not automatically populate.  
 

Prompt Values that you will select 
when you run the query 

Edit default prompt text in 

text box. Click  Prompt 
Properties for more options. 
  

Results from another query 
 

Use a list generated by 
another query, for example: a 
list of UINs from another 
spreadsheet. Note there is an 
Oracle limit of 1000 values.  
 

Select Results from another 
query then select the data 
provider from list.  
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Appendix E: Changing the Default Style Sheet 

When you create a report or add a report element in a Web Intelligence document, the 
formatting is entirely based on the default style, which is stored in a Cascading Style Sheet 
(CSS). The style sheet has the default format for many different elements, like the size of the 
paper and the margins for a new report. 
 
The default location of this standard CSS file is: 
C:\Program Files(x86)\SAP BusinessObjects\SAP BusinessObjects Entreprise XI 
4.0\images\WebIDefaultStyleSheet.css 
You can make changes to this file so that the default styles of elements are what you want. 
You should make a backup copy of the file first. 
 
Here is a sample of the REPORT section of the file with the page size changed to letter (8.5” x 
11”) and the margins set to 0.5”. 
 
/*  Chap.2 : Report and Areas */ 
/* -------------------------- */ 
 
REPORT { 
 page-format-dimension-width:8.5 in;  /* Units available: centimeters (cm), 
millimeters (mm), inches (in), and metric (no unit)   */ 
 page-format-dimension-height:11 in;    /* '...height:1.0in;'  equals  '...height:2.54cm;'  
and equals '...height:3600;'  */ 
 page-format-margin-top:0.5 in;  /* Printing page margin  */ 
 page-format-margin-left:0.5 in; 
 page-format-margin-bottom:0.5 in; 
 page-format-margin-right:0.5 in; 
 page-records-horizontal:20;  /* Number of records displayed in one page in 
quick display mode (approx., the total number of columns in tables) */ 
 page-records-vertical:100;  /* Number of records... The same for rows */ 
} 
 
To reset the document default style to the standard style, in the Properties tab, click 
Document > Reset standard Default Style. The standard CSS will replace the previous CSS in 
the document. 
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